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7. THE USER INTERFACE

This chapter covers the basics of using the window system 

NoteCards is built on top of.  Read this chapter if you are a new 

user of the system or you need to understand how to manipulate 

windows, icons, and use the functions on the background menu.  

For a lower-level introduction to mouse-button and keyboard use, 

read Chapter 5, NoteCards Basics.

This chapter explains:

Where to find system menus.

What these menus do.

The Window Menu

The NoteCards window system allows you to interactively 

manipulate the windows on the screen, moving them around, 

changing their shape, etc. by selecting various operations from the 

window menu.  

Figure 7-1.  The window menu.

When you press and hold down the right mouse button in a 

window’s title bar, as shown in Figure 7-2,  that window will come to 

the top and a menu of window operations will appear.  In some 

cases, you can hold down the right mouse button anywhere in the 

window to access the window menu. 
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Figure 7-2.  The window menu being accessed 

from a TEdit-window title bar.  Note how the TEdit 

window has been brought to the top of all the 

windows.

Close

Closes a window, i.e., removes it from the screen.  If you have 

modified the contents of the window, the system may ask you to 

confirm, by pressing the left mouse button, that you want to close 

the window and lose your changes.  Pressing the right or middle 

mouse button cancels the close operation.

Figure 7-3.  A TEdit window requesting you to 

confirm the Close command.

Snap

Prompts for a region on the screen and makes a new window 

whose image is a snapshot of the image currently in that region.  

Useful for saving some particularly choice image before the window 

image changes.
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Figure 7-4.  The mouse cursor prompting you to 

sweep out a new size and shape for a window.

Most of the images presented as figures in this manual are screen 

snaps.

When making a snap, it is possible to change corners and change 

the snap shape from a different side of the ghost frame.  In the 

middle of a snap process, while you still have the left mouse button 

down, simultaneously press and hold down the right mouse button.  

When you do this, the forceps cursor ( ) will appear.  Move this 

cursor to the corner of the ghost frame you want to move and still 

holding the left mouse button down, release the right mouse button.  

You will now be able to adjust the snap from the corner you just 

selected.  

Paint

Switches to a mode in which the cursor can be used like a paint 

brush to draw in a window.  This can be useful for making notes on 

a window or touching up snaps.  While the left key is down, pixels 

are blackened.  While the middle key is down, they are erased.  

The right button pops up a command menu that allows you to 

change the brush  size, shape, shade, mode, and to quit the paint 

utility.  

Figure 7-5.  Paint command menu.

Set Mode

Brings up the menu shown in Figure 7-6.

Figure 7-6.  The Mode menu for Paint.

Changing the paint mode changes the way the bits in the brush 

combine with the existing bits in the snap.

    

Figure 7-7.  The vertical bars show a sample bit 

map pattern from a snap.  The horizontal bars are 

the pattern in the example brush.
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Replace Invert Add

Figure 7-8.  The snap and brush patterns shown in 

Figure 7-7 combine as shown here.  

Set Shade

Pops up a menu which allows you to choose one of a preexisting 

set of shades or specify your own 4x4 shade.  New shades are 

added to the "Choose shade" menu.

Figure 7-9.  The "Choose shade" menu.

Figure 7-10.  The 4x4 shade tool.

Set Shape

Pops us the menu below which allows you to set the shape of the 

mouse cursor.

Figure 7-11.  The shape menu.
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Set Size

Brings ut the following menu which sets the cursor brush size.

Figure 7-12. The size menu.

Quit

Quits the paint program.

Clear

Clears the window.  Sets all pixels in the window to white.

Bury

Places the window under all other windows which it covers or 

overlaps, thereby exposing any windows that it was hiding.

Redisplay

Clears the window and rewrites the window contents to the window.

Hardcopy

Sends the contents of the window to the printer.  If the window is 

associated with a text, sketch, or graph editor the editor’s contents 

are printed.  In the case of TEdit and Sketch, this means that the 

associated TEdit file, if there is one, is printed.  If the window is not 

associated with an editor a bit-map image of the window is sent to 

the printer.

To save the image in a PostScript, Interpress, or Press formatted 

file, or to send it to a non-default printer, use the submenu of the 

Hardcopy command.  When the mouse is moved off to the right of 

the Hardcopy menu item, a second pop-up menu appears giving 

the choices To a file or To a printer.

Figure 7-13.  The Hardcopy submenu.
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If To a file is selected, you are prompted to supply a file name, and 

the format of the file (PostScript or Interpress) from the "File type?" 

menu and the contents of the window is stored in that file, formatted 

for the printer type you specified.  

Figure 7-14.  The "File type?" menu.

The system provides the suffixes for these files.  PostScript files 

have a "ps" suffix.  Interpress files have an "ip" suffix.  For example, 

given a file name of "Letter," the system stores a file with the name 

"Letter.ps" for a PostScript formatted file and "Letter.ip" for an 

Interpress formatted file.  If you change the suffix for a formatted file 

from "ps" or "ip" to some other name, the system will prompt you to 

let it know the file type when you try to print the file.  For a 

formatted file, select the BINARY response. For an unformatted 

file, select the TEXT response.  You print a formatted file the same 

way you print an unformatted file, by using the Hardcopy option on 

the FileBrowser menu.

Figure 7-15.  The "File Type?" menu requesting the 

file type of a file formatted for a particular printer 

type.

If you select To a printer, you are prompted to select a printer from 

the list of known printers, or to type the name of another printer.

Figure 7-16.  The "Which printer?" menu asking 

which printer you want to send to.

The topmost printer in the "Which printer?" menu is the default 

printer.  If the printer selected is not the topmost printer on the list, 

indicating that it is not the default printer, you will be asked whether 

to make the printer you selected the new default printer.

Figure 7-17.  The "Make this the new default?" 

menu asking you whether you want to make the 

printer you selected the default printer.

Note, unless you are using only fully specified Interpress printer 

names or you have set the DEFAULTPRINTERTYPE variable from 

your initialization file, it is unadvisable to use the Other... option on 

the "Which printer?" menu shown in Figure 7-16, as using this 

option does not allow you to specify the printer type.
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Move

Moves the window to a new screen location.  When you select 

Move you are presented with a ghost frame which is the size and 

shape of the original of the window you are moving.  You move the 

mouse to position the ghost frame where you want the window to 

appear and then you plant the window by clicking the left mouse 

button.

Figure 7-18.  A TEdit window and its ghost frame.

Shape

Allows the user to specify a new size and shape for an existing 

window.  You can use either the left or middle mouse buttons to 

shape a window.  

Using the left mouse button allows you to change the size, shape, 

and location of a window.  Once you have selected Shape from the 

window menu, position the cursor where you want the upper left 

corner of the window to be located, press and hold down the left 

mouse button, sweep out a new region for the window, and release 

the mouse button when the window has the size and shape you 

want.

Using the middle mouse button allows you to change the size and 

shape of a window by moving just one corner of the window.  

Select Shape from the window menu and  position the mouse 

cursor at the corner you want to move.  Press and hold down the 

middle mouse button and move the mouse cursor to the location 

you want that corner of the window to be at.  A ghost frame will 

appear to indicate the new size and shape of the window.

When reshaping a window with either the left or middle mouse 

button it is possible to change corners and change the window 

shape from a different side of the window.  In the middle of a shape 

process, while you still have the left or middle mouse button down, 

simultaneously press and hold the right mouse button down.  When 

you do this, the forceps cursor ( ) will appear.  Move this cursor 

to the window corner you want to move and still holding the left or 

middle mouse button down, release the right mouse button.  You 

will now be able to reshape the window from the corner you just 

selected.  

If you have too many windows on the screen and you are having 

problems accessing them, you probably want to try shrinking some 

windows. 
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Shrink

Removes the window from the screen and brings up its icon.  The 

window can be restored by clicking the middle mouse button inside 

the window’s icon, or by selecting Expand from the right button 

icon menu.  Some icons are shown below.

Figure 7-19.  TEdit-window shrink icons look like books.

Figure 7-20.  Sketch-window shrink icons look like 

sketch pads.

Figure 7-21.  FileBrowser-window shrink icons look 

like filing cabinet drawers.

Figure 7-22.  The NoteCards MenuBox shrink icon 

looks like a recipe file box.

Figure 7-23.  Notecard shrink icons look like link 

icons with an extra border.

The Icon Menu

Icons are a varient of windows and have a menu similar in form and 

function to the window menu.
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Figure 7-24.  The icon menu.

For the options Close, Snap, Paint, Bury, Move, and Shape see the 

discussion above under the "Window Menu" heading.

Expand

Restores the window associated with the icon accessed and 

removes the icon image from the screen.  You can also expend an 

icon by clicking the middle mouse button inside the icon.

The Background Menu

If the right button is pressed while the cursor is not in any window, 

the background menu appears.

Figure 7-25.  The background menu.

TEdit

Opens a new TEdit window and starts a new TEdit session.

Sketch

Opens a new Sketch window and starts a new Sketch session.
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Figure 7-26.  The Sketch submenu options.

Page sized sketch

Allows you to start a sketch which will fit exactly on an 8 1/2 x 11 

inch sheet of paper when held in the normal vertical or portrait 

position.

Landscaped sketch

Allows you to start a sketch which will fit exactly on an 8 1/2 x 11 

inch sheet of paper when held in a horizontal or portrate position.

Sketch, from a file

Allows you to start a preexisting sketch which is stored in a file.

NoteCards

Opens the NoteCards MenuBox Icon which is the interface for a 

NoteCards session.

Snap

The same as the window menu command Snap described above.

Also, TEdit, Sketch, and NoteCards allow information to be shift-

inserted at the current cursor position by selecting an area of the 

screen with the SHIFT key held down.  To shift-insert the bitmap of 

a snap into an editor, position the cursor where you want the image 

to appear, hold the SHIFT key down, press and hold down the right 

mouse button in the background, and select Snap from the single 

item menu which appears.  Finally, sweep out the area for the snap 

and release the mouse button and the SHIFT key.  The snap will 

appear in the editor where the cursor was positioned.  Note, 

sometimes it is necessary to scroll or redisplay the window for the 

snap to appear.

Hardcopy

Prompts for a region on the screen, and sends the bit map image to 

the default printer.  Note that the region can cross window 

boundaries.

Like the window menu Hardcopy command discussed above, you 

can print to a file or specify a different printer than the default by 

using the Hardcopy submenu.  See the discussion of the Hardcopy 

command under the "Window Menu" section above, for more detail.
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Clocks

Starts an analog clock and places it on the screen.  The Clocks 

submenu gives you access to a digital clock.

Figure 7-27. The Clocks option on the background 

menu.

For a complete discussion of this menu option, see Chapter 15, 

Other Tools.

FileBrowser

Opens a FileBrowser window which prompts you for a directory to 

browse.  

For a complete discussion of this menu option, see Chapter 14, 

The FileBrowser.

Directory Connector

Opens a window which displays your currently connected directory, 

and allows you to change directories.

For a complete discussion of this menu option, see Chapter 15, 

Other Tools.

 Idle

Enters idle mode, which blacks out the display screen to save the 

phosphor.  Idle mode can be exited by pressing any key on the 

keyboard or mouse.  This menu command has subitems that allow 

the user to interactively set idle options to erase the password 

cache (for security), to request a password before exiting idle 

mode, to change the timeout before idle mode is entered 

automatically, etc.

Figure 7-28.  The Idle submenu.

If either shift key is pressed while NoteCards is in idle mode, the 

current user name and the amount of time spent idling are 

displayed in the prompt window.  This information appears as long 

as the shift key is held down.
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Show Profile

Displays the current idle profile in the system prompt window.

Set Timeout

Sets the amount of time that the machine will wait for a key stroke 

or mouse click before automatically going into idle mode.

When you select this option the system brings up a number pad on 

which you can enter the new idle time out.  An idle time out of zero 

sets the machine so that it will never go into idle mode.

Figure 7-29.  The number pad menu requesting a 

new idle timeout duration.

The submenu option Never, will set the machine so that it never 

goes into idle mode.  We counsel against using this option as it can 

result in the phosphor on your screen being damaged.

Choose Display

Allows you to select what will be displayed on the blacked out 

screen when the machine is in idle mode.  Selecting this option 

brings up the two-choice menu shown below.

Figure 7-30.  The idle display menu.

Bouncing Box Chooses the Envos logo as the idle display.

Figure 7-31.  The Bouncing Box Envos logo.

Bouncing Username Chooses the your username as the item to bounce around on the 

screen while in idle mode.
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Forget

If set to "Don’t" (or NIL), your password is not erased when idle 

mode is entered.  Default is "Do" (or T(rue)) erase password.  The 

initialization file distributed with the NoteCards system resets 

Forget to "Don’t."

Figure 7-32.  The Forget submenu.

Note:  If the password is erased, any programs left running when 

idle mode is entered will fail if they try doing anything requiring 

passwords, such as accessing file servers.

Allowed Logins

Determines who can exit idle mode. 

Figure 7-33.  The "Allowed Logins" submenus.

Unlocked Sets the system such that login is not required to exit idle mode.  

Initialization file value is "NIL."

Locked Lets only the previous user exit idle mode.  Initialization file value is 

"(T)."

Any Login Require login, but let anyone exit idle mode.  Login overwrites the 

previous user’s user name and password each time idle mode is 

exited.  Initialization file value is "(*)."

Group Allow any members of a specified group to exit idle mode.  Figure 

7-33 shows the Group submenu which allows you to add and 

delete group members.

Authenticate

The value of this property determines what mechanism the system 

uses to check passwords.  

Figure 7-34.  The Authenticate submenu.

If the value of this property is "Do" or "T(rue)," the Xerox network 

system protocol is used to do the authentication.
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If the property value is "UNIX," the Sun Operating System is used 

to do the authentication.  This option is set in the standard 

initialization file.  See Appendix C for a complete discussion.

If the value of this property is "Don’t" or NIL, the password is not 

checked.  Any password is accepted.

Logout

Saves the NoteCards virtual memory working image to a file and 

returns the system to UNIX.  This is the normal way to return to 

UNIX.

Figure 7-35.  The Logout option and its submenu 

on the background menu.

Save image & Exit

The same as Logout.

Flush image & Exit.

Returns the system to UNIX without saving the working image.  

Use this option when you have saved all your work to files and you 

do not care if the system comes up in the same state it was in when 

you left it.

Save VM

Saves the NoteCards virtual memory working image to a file but 

does not return the system to UNIX.  Use this option frequently if 

you are concerned about power failures or other problems which 

may cause your machine to crash.

Suspend & Exit

Suspends the NoteCards session and returns control to UNIX.  You 

restart the NoteCards session by entering the command fg  

(foreground), at the UNIX prompt.

Low Level Tools

This menu option provides people extending the NoteCards system 

access to the Lisp executives, the process status window, and 

allows them to set the Show TEdit Props flag.  The NoteCards 

user should never access these options except under the 

instruction of a developer or support person.
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Set Default Printer

Allows you to specify which printers you want to print to and which 

one is the default.

For a complete discussion of this menu option, see Chapter 16, 

Printing.

Postscript Parameters

Allows you to control the way PostScript documents are printed.

For a complete discussion of this menu option, see Chapter 16, 

Printing.

Set Default Display Font

Brings up a series of menus which allow you to specify what fonts 

will be used on the screen.  This is a particularly useful option if you 

are using a high resolution screen and want to increase font size or 

for people who are vision impaired.

Figure 7-36.  The "Choose Font Profile to Update" 

menu.

To change a display font, select the Set Default Display Font 
background menu option and choose the font you want to change 

from the "Choose Font Profile to Update" menu.  Each of the font 

options is discussed below.  Once you have selected the font you 

want to modify, the "Please select a font:" menu will appear.  Select 

the font family, size, and face you want then select DONE.  RESET 

makes the menu display the current setting for the default display 

font you are modifying.  ABORT terminates this operation and 

closed the "Please select a font:" menu.

Figure 7-37. The "Please select a font:" menu.

If you choose a font which does not exist or the system is unable to 

find, the old font specification remains unchanged.  
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If the system is unable to find a font which you know to exist, check 

the setting of the display font directory list.  This is done with the 

Show Font Directories subsubmenu option off the Set Default 
Printer background menu option.  See Chapter 16, Printing, for a 

complete description of how to use this option.

FileBrowser Display Font

The font in which the information in the main display window is 

printed, initially 10-point Gacha.

FileBrowser Prompt Font

The font in which FileBrowser prompt messages are printed.  

Initially 8-point Gacha.  Changing this value only affects new 

FileBrowsers created from the background menu.  Existing 

FileBrowsers are unaffected.

Prompt Window Font

The font used to print information in the black system-prompt 

window.

Default Font

The starting font used in TEdit and Sketch windows as well as all 

other windows which do not have an explicitly specified font 

associated with them.  

Note that the default font for NoteCards cards is specified from the 

"NoteCards System Parameters" menu.  See Chapter 13, System 

Parameters for a complete discussion of how to specify this default 

font.

Menu Font

The font used in all system menus.  The menu font is used in the 

window, icon, background, and other menus.
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